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Thank you for choosing our SLgateway product! 

General overview 
SLgateway is an IoT station developed with the aim to reduce the cost of deploying a 

radio network for small and medium size applications. 

 

 

The gateway integrates the SLbase software designed to meet the need for a plug and 

play LoRaWAN™ local network solution: 

• All in one LoRaWan solution with RF modem, Network & Application layers 

• Graphical user interface for managing LoRa devices, accessing to application 

data (measures, payloads) and RF network information, and secured access to 

gateway 

• Various types of API to access device data (Rest API, HTTP Callback, Modbus, MQTT) 

The Gateways range 

All gateways references embed SLGatewayV2. 

Part number Gateway name Modem Channels Protection level 
Dimensions / Weight 

(without accessories) 

PIC-LAB-63NS Pico GPRS 
GPRS 3 CH IP30 

(indoor use) 
101x74x35 mm / 135 gr 

GAT-LAB-6NN3 Gateway-8CH 
No 8 CH IP30 

(indoor use) 
126x80x46 mm / 290 gr 

 

 

 

 

 

 

 

  Pico GPRS       Gateway-8CH  

LoRa devices 
(sensors...)

SLgateway

Final customer 
Application

•WebApp

•PLC

•...

Figure 1 : SLGateway basic diagram 
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SLgateway main features 

LoRaWan 

✓ Support of LoRaWan 868MHz devices, configurable in ABP / OTAA for PUBLIC 

network with configurable AppEUI 

✓ Network level supervision with highlight of disconnected devices  

✓ Up to 200 devices with 1 message transmission every hour 

✓ Storage of all received data for 100 days 

For more information about the LoRaWAN concept and technology, we advise you to 

read these documents: 

• General overview: LoRaWAN™ What is it? 

• Technical description: LoRaWAN™ 101 – A Technical Introduction 
(source: lora-alliance.org) 

 

Graphical user interface (GUI) 

✓ Add/ Import/Remove devices 

✓ Quick visualization of current device measures 

✓ Quick visualization of current device network state 

✓ Export all displayed data in CSV format file 

✓ Export all stored data in CSV format file (since V2.3.0) 

✓ Remotely downlink message management (reconfiguration for Senlab) 

✓ Graphical configuration of system (IP network, log access, …) 

✓ Backup/restore services configuration 

✓ RF range test dashboard and results export: SLtester tool 

✓ Same GUI for all SLgateway references 

 

Data APIs access 

✓ REST API: SLbase HTTP standard API for accessing all data in application/xml or 

application/json formats  

✓ HTTP Callback(s): Real time customer listener notification of received 

data/payload/status in json or xml format 

✓ Modbus API:  Gateway as a TCP Modbus slave for getting data threw a PLC system 

✓ CSV to FTP: Periodic transfer of CSV format file on an FTP/SFTP server of last received 

data (for Senlab only) 

✓ MQTT: Subscription management to services, real time data notification to 

customer server 

✓ Elasticsearch: RESTful search and analytics engine capable of solving a growing 

number of use cases (www.elastic.co) 

✓ Sentilo: open source sensor and actuator platform designed to fit in the Smart City 

architecture (www.sentilo.io) 

(refer to section “STEP 4” for more details and “how to use” for each APIs) 

  

https://docs.wixstatic.com/ugd/eccc1a_ed71ea1cd969417493c74e4a13c55685.pdf
https://docs.wixstatic.com/ugd/eccc1a_20fe760334f84a9788c5b11820281bd0.pdf
https://www.elastic.co/
http://www.sentilo.io/
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SLgateway specification 

 

  
Specification Description 

Operating system (OS) Linux Debian 

Ethernet RJ45 plug 

GSM/GPRS (picoGW only) GPRS modem (full-size SIM card) 

Database Storage of last 100 days data 

Data APIs access 

IoT platform compatibility 

Rest API, HTTP Callback(s), CSV to FTP, Modbus TCP 

 DEXCell(Dexma), Sentilo 

MQTT, Elasticsearch 

Graphical User Interface Light GUI for gateway configuration & management 

Security Login/Password authentication (HTTP security) 

Firewall rules 

RTC (picoGW only) Hold current clock/date without external power supply. 

Software maintenance Easy update from GUI (or SFTP) 

Advanced configuration processes (SFTP) 

Backup/Restore Backup and restore all service configuration of the SLgateway 

For massive SLgateway configuration 

CSV data export Export all data or from selected days to CSV file 

Remote access VPN: Easy activation for remote access for SL support team 

(you can also to connect to your own OpenVPN server) 

DynDNS: need dynDNS account and a public IP 

Ngrok: need  ngrok account, work with private or public IP 

Remote management 

(since V2.4.x) 

Embedded tools and features for GW fleet management: 

(with REST API, MQTT, HTTP callback, or ngrok): 

- automatic send of gateway and device status 

- remote reconfiguration for gateway and devices 

RF ISM 868Mhz band (Power +14dBm / Sensitivity -137dBm) 

RF Range tester Local LoRaWAN network coverage test dashboard 

(required a Senlab Test devices) 

LoRaWan network server ABP or OTAA activation mode 

PUBLIC (default since V2.0.2) or PRIVATE network type 

Downlink acknowledge option 

picoGW: 3 channels (868.1,868.3,868.5MHz)mono datarate (SF12) 

Gateway-8CH: 8 channels - ADR from DR0 (SF12) to DR5 (SF7) 

LoRaWan application server Application messages Decryption & Encryption 

Integrates SLcodec for Senlab messages decoding  

https://ngrok.com/
https://ngrok.com/
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Before starting, remember the 4 steps to make the global system fully operational: 

 

STEP 1 STEP 2 STEP 3 STEP 4 

This document describes all these 4 steps. 

We strongly advise to back up the full gateway configuration after the on-site 

deployment step, after first data (Refer to Maintenance - Services section) 

 

STEP 1: Configuration & Installation of gateway 

SLgateway assembly (picoGW) 

The delivered package includes:  

1. A GSM/GPRS antenna (the smaller)  

2. An 868MHz LoRa antenna (the longer) 

3. An ethernet cable (Cat 5.e - 1m) 

4. A 230V power adapter 

5. The SLgateway 

6. The “Getting started” document 

 

Assembly of the SLgateway (picoGW) 

1. Insert SIM card: 
✓ open the upper side of the gateway casing   

✓ LOCK the grey cap by pushing it outwards 

✓ Close the upper side of the gateway casing 

2. Screw both antennas 

3. Plug the power supply 
✓ To prevent electronic damage: 

the gateway must not be powered without antennas 

  

Configuration & 
Installation of 

gateway

Device 
provisioning 
into gateway

Activation of 
the device

Device data 
access via APIs

 1  2  3  4  5  6 
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SLgateway assembly (Gateway-8CH) 

The delivered package includes:  

1. An 868MHz LoRa antenna 

2. An ethernet cable (Cat 5.e - 1m) 

3. A 230V power adapter (microUSB) 

4. The SLgateway 

5. The “Getting started” document 

 

Assembly of the SLgateway (Gateway-8CH) 

1. Screw the antenna 

2. Plug the power supply on micro USB port (see photo) 
✓ To prevent electronic damage: 

the gateway must not be powered without antenna 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 1  2  3  4  5 
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SLgateway positioning 

➢ Position both antenna with 90° elbow and its main part upwardly (vertical) in free 

space area 

➢ Avoid positioning the SLgateway against or inside metallic/electric elements 

o If not possible, use RF cable extension to position outside the LoRa antenna 
(see photos on next page) 

      

 

➢ If LoRa devices are in a different building than or outside the building where the 

gateway is installed, it is recommended to deport antennas (at least LoRa 

antenna) and/or SLgateway on a higher position. 

       

First access to the GUI (over ethernet on 192.168.2.1) 
Computer     SLgateway 
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Steps to follow with default configuration1:  

1. Start your SLgateway (power up) 

2. Configure your computer1 

IPv4 static address: 192.168.2.2 

subnet mask 255.255.255.0 

(PC network Ethernet properties) 

3.  Connect your computer to SLgateway using the Ethernet cable 

4. Access to http://192.168.2.1 (check this FAQ here about browsers compatibility) 

5. Enter default user/password when asked: public/public 

 

Congratulations! You are now connected to the SLgateway. 
 

 

  

 
1 Default configuration of SLGateway is static IP 192.168.2.1 

Trick: If the time is frozen, the 

connection is lost (or bad) 

http://192.168.2.1/
https://support.sensing-labs.com/hc/en-us/articles/360015486292-28-Does-SLgatewayV2-work-fine-with-my-web-browser-
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Set SLgateway local time 

After 1st boot, you have to synchronize the timestamp of the gateway: 

1. Check if your computer local time is OK? 

2. Access to the “Maintenance  → System” page 

3. Click  and confirm at the pop-up screen. 

4. Check the new SLgateway UTC time in the right bottom part of the GUI screen. 

 

Some important points to know about SLgateway clock: 

- because of the hardware clock drift, and because all data are timestamped 

with this clock, you need to be sure the clock is often updated. 

- you need to update it manually (“Sync Date Time” button) before to start any 

communication with devices 

- “PicoGW” hold the current clock (with drift) even if not powered 

- “Gateway-8CH” don’t have internal self-powered RTC: it will restart with the last 

clock 
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GW with internet access ? 
(Ethenet or GPRS)

YES

Nothing more to do:
Clock is automaticly 

updated
(with public NTP server) 

NO

Is there a local NTP server ?

YES

You need to customize
the NTP server address.

(refer "advanced configuration")

NO

You need to implement an periodic process 
to update the clock

(once a day for example):
- with Modbus API (refer to Modbus API section)

OR
- with REST API (refer to REST API section)
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Authentication password configuration  

We advise you to replace the default password from “Maintenance → GUI Settings” 

➢ In case of password lost, please create an online ticket here 

➢ You can also change the friendly System Name into the same page 

Ethernet interface configuration 

You can change the default Ethernet configuration to fit to your local network from 

“Maintenance → System”, with button  

➢ If you lost the current IP address, you can use the Over USB connection, refer to 

troubleshooting section: I have forgotten the current IP network gateway configuration 

➢ If you need to configure Ethernet to a static IP on a local network, refer to 

troubleshooting section:How to configure my SLgateway to static IP address 

(Ethernet)? 

➢ You can “ping” a server to check your configuration (result is in “Network log”) 

GSM/GPRS configuration (picoGW only) 

1. Check the SIM card and GSM/GPRS antenna are well installed (cf. “STEP1”) 

2. Access to “Maintenance → System” page 

3. In section “GSM configuration”, fill the fields with GSM/GPRS information (given by 

your SIM card provider): 

✓ PIN code (optional) 

✓ APN (required) 

✓ Username and password (for PAP or CHAP authentication) 

 

4. Apply new configuration with  (see “network log” screen for detail) 

(if you enter a PIN code, you will need to reboot with ). 

If successful, “ppp0” appears in IP network interface.  

5. Once the settings are OK reboot with  to save  

 

6. definitely into the gateway. 

After a boot or reboot, all configuration and stored data can take 2 minutes to be 

fully loaded. 

You can check the GSM/GPRS quality level  (updated only after ). 

You can stop the GSM/GPRS connection when you want with button .  

https://support.sensing-labs.com/hc/en-us/requests/new
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Easy gateway update from GUI (from V2.3.0) 

The update file must be: 

- lower than 10 MB (V2.3.x) (a patch is available to expand this limit to 150MB) 

- lower than 150 MB (V2.4.1) 

If you need to load a larger file, please use SFTP process. 

1. Get your update file (extracted from zip) 

2. Access to “Maintenance → Update” page 

3. Load the update file (generally named update.run.enc) – can take up to 1 min. 

4. Reboot & Wait some minutes (up to 6 minutes for major update) 

5. Connect to GUI and check version number (footer) 

 

 

 

 

SFTP access (for Update & advanced configuration) 

(for expert in network management only) 

Requirement: 

➢ Local access to the SLgateway (with Ethernet cable) 

default Gw IP 192.168.2.1 --> Check your Computer is on the same subnetwork 

Also possible with GPRS connection in some cases (not for update) 

➢ Filezilla-client software installed on your computer 

➢ The “sshpass” (different for each gateway), please ask us here: send us the  

Gateway ID (xxxBBBKxxxx format) 

Launch Filezilla software: 

1. “File→Site Manager” 

2. Create a new site with: 

✓ Host: 192.168.2.1(default) 

✓ Port: 2022 

✓ Protocol: SFTP 

✓ Logon Type: normal 

✓ User: public 

✓ Password: your_ GW_sshpass 

3. Save and connect 

 

You can now have an access to several directories and file for updating or advanced 

configuring (see next section).  

https://filezilla-project.org/download.php?type=client
https://support.sensing-labs.com/hc/en-us/requests/new
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Advanced configuration  

(for expert in network management only) 

In case of SLgateway massive deployment, you can configure all in one (for all 

SLgateways) in the same process, only for these configurations: 

• NTP server 

• DNS server 

• Host (only specifics server addresses) 

• Firewall rules 
 

DynDNS 

You can use the DynDNS service to connect remotely to your SLgateway if the IP 

change (require an PUBLIC IP). 

Since V2.4.2, this function is disabled by default. 

Contact us if you want activate this function.  

NTP server 

You can customize the NTP server by filling your own NTP server address. 

Requirement: 

➢ Active GPRS or local ethernet connection 

➢ SFTP access (see SFTP access (for Update & advanced configuration)) 

Process: 

1. Connect to the picogw via SFTP protocol (with Filezilla software) 

2. Copy the files timesyncd.conf from /update/templates/ to your computer 

3. Edit the timesyncd.conf file and replace the default NTP server address 

4. Save and copy the new file to /update via SFTP 

5. Reboot SLgateway (GUI: “Maintenance→System→Reboot”) to load the file 

6. Reboot one more time to apply new settings 
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Hostname/hosts customization 

You can change the hostname of your SLgateway, useful in a DHCP configuration. 

You can also add your specifics server address in hosts file. 

Requirement: 

➢ Active GPRS or local ethernet connection 

➢ SFTP access (see SFTP access (for Update & advanced configuration)) 

Process: 

1. Connect to the picogw via SFTP protocol (with Filezilla software) 

2. Copy the files hostname and hosts from /update/templates/ to your computer 

3. Edit the hostname file and replace the default hostname (slbasev2inside) 

4. Edit the hosts file and replace the default hostname in the first line 
OPTIONNAL: add your specifics server addresses after the last line 

5. Save and copy the new files to /update via SFTP 

6. Reboot SLgateway (GUI: “Maintenance→System→Reboot”) to load the files 

7. Reboot one more time to apply new settings 

 

DNS server customization 

You can change/add DNS server(s) of your SLgateway, useful in a “Static IP” 

configuration and local network. 

Requirement: 

➢ Active local ethernet connection 

➢ No GPRS connection (the GPRS connection will rebuild a new resolv.conf file) 

➢ SFTP access (see SFTP access (for Update & advanced configuration)) 

Process: 

1. Connect to the picogw via SFTP protocol (with Filezilla software) 

2. Copy the files resolv.conf from /update/templates/ to your computer 

3. Edit the resolv.conf file and add/replace the DNS server(s) you want to use 

(keeping the format the format nameserver x.x.x.x) 

4. Save and copy the new files to /update via SFTP 

5. Reboot SLgateway (GUI: “Maintenance→System→Reboot”) to load the files 

6. Reboot one more time to apply new settings 
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Custom OpenVPN client 

You can configure SLgateway to connect to your own OpenVPN server. 

Requirement: 

➢ OpenVPN server reachable from public IP address 

➢ OpenVPN client configuration file (rename xxxx.ovpn to custom.conf) 

IPV6 is not supported by SLgateway (ask us for more detail) 

You need to add 

➢ Internet access, from GPRS or ethernet connection 

➢ customvpn.redis file (ask for it on support.sensing-labs.com) 

➢ SFTP access (see SFTP access (for Update & advanced configuration)) 

Process: 

1. Load customvpn.redis in SLgateway (GUI: “Maintenance→Services→Restore a 

service backup). Confirm with “Yes” when pop up ask it. 

2. Wait one minute (services will restart) 

3. Check “Custom VPN” menu appears (GUI: “Tools→Remote management) 

If not, refresh the page (press F5 on keyboard) 

4. Connect to the picogw via SFTP protocol (with Filezilla software) 

5. Copy the files custom.conf to /openvpn 

6. Press and check your GW is connected to your VPN: 

If successful, “tun0” appears in IP network interface 

(GUI: “Maintenance→System) 
 

 

 

7. If you want to force VPN connection when GW restart, active with (by default, 

persistence is disable) 

8. Reboot and check VPN connection is automatically started. 
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Firewall rules  

Warning: 

In case of bad firewall rules, you can lose communication with SLgateway 

 

You can customize firewall rules to increase the security level. 

Requirement: 

➢ Active local ethernet connection 

➢ SFTP access (see SFTP access (for Update & advanced configuration)) 

➢ UFW knowledge (online documentation here) 

Remember: Port 80 = GUI and REST API     port 2022 = SFTP/SSH   port 502 = Modbus 

Process: 

1. Connect to the picogw via SFTP protocol (with Filezilla software) 

2. Copy the files template_fw.rules from /update/templates/ to your computer 

3. Edit the file and add the rules you want 

(allow port 502 and 5020 if Modbus) 
delete allow in on eth0 to any port 80 proto tcp  

delete allow in on eth0 to any port 2022 proto tcp 

delete allow in on eth0 to any port 502 proto tcp 

delete allow in on eth0 to any port 5020 proto tcp 

delete allow in on ppp0 to any port 80 proto tcp 

delete allow in on ppp0 to any port 2022 proto tcp 

allow from <your_ip_or_network> to any port 2022 proto tcp 

allow from <your_ip_or_network> to any port 502 proto tcp 

allow from <your_ip_or_network> to any port 5020 proto tcp 

allow from <your_ip_or_network> to any port 80 proto tcp 

4. Save as firewall.rules and copy the file to /update via SFTP 

5. Reboot SLgateway (GUI: “Maintenance→System→Reboot”) to load the files 

6. Reboot one more time to apply new settings 

You can check the current FW rules and check previous UFW actions: 

/update/update.log 

To restore the initial FW rules, you need to delete allowed IP you had before (edit 

and reboot). 

For example remove 192.168.1.247 (old IPs can be retrieved in sftp update.log 

file): 
allow in on eth0 to any port 80 proto tcp 

allow in on eth0 to any port 502 proto tcp 

allow in on eth0 to any port 5020 proto tcp 

allow in on eth0 to any port 2022 proto tcp 

delete allow from 192.168.1.247 to any port 2022 proto tcp  

delete allow from 192.168.1.247 to any port 80 proto tcp 

  

https://help.ubuntu.com/community/UFW
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STEP 2: Device provisioning into gateway 
SLgatewayV2 is configured in PUBLIC LoRaWan network with appEUI 70B3D580A0000000 

➢ It supports both OTAA & ABP activation type. 

➢ You have to check that your devices are commissioned in PUBLIC mode 

(with SLsetting tool for Senlab) 

➢ For any other configuration, please create an online ticket here: 

Add a new device 

1. Access to “Network” page & click on button  

2. Enter device provisioning information 

• Name: friendly name of device displayed into GUI 

• Activation: OTAA or ABP 

• DevEUI: Unique identifier of LoRa device (IEEE EUI64 address) 

• For ABP: devAddress, NwkSKey & AppSKey 

• For OTAA: Application key  

3. Confirm with button  

The new device will appear into “Application” and “Network” page. 

You can now immediately install and activate it! (see device User Guide)  

If you don't have the device keys, contact your distributor/reseller with devEUI. 

Add multiple devices at once 

For importing multiple devices at once, you have to use the SLsetting import feature. It 

allows you to add all new devices contained into a CSV file (generated with 

SLsetting). 

1. Access to “Tools → SLSetting import” page 

2. Choose the csv file to import using button  

3. Check device list (Fw type, Activation, …) and add them with button   

 

The new device will appear into “Application” and “Network” page. 

You can now immediately install and activate it! (see devices User Guide) 

 

Since V2.4.2, you can see the number of registered devices in the footer: 

(you could need to refresh the page with F5 key if you add/remove device) 

 

  

Number of registered devices 

(29 devices in this example) 

https://support.sensing-labs.com/hc/en-us/requests/new
https://support.sensing-labs.com/hc/en-us/articles/360004604751-User-Guide
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Remove a device 

To remove a device, you have to go into Network device detail page, and to confirm 

the suppression with button   

When you remove a device in SLgateway, the device still “keeps” the 

NetworkSessionKey and if OTAA, you will need to “disconnect” the device itself or 

recommission it again. 

You can also send a “STOP application” request to the Senlab before to remove it 

from SLgateway. 

 

Before to remove device, check device behaviour in this case, especially if you 

want to move the device to another network. Check the FAQ here. 

STEP 3: Activation of device 
 

You have now to install & activate your device 

➢ Do not activate devices too close to the gateway 

o keep a minimum distance of 1 meter 

➢ For Senlab activation process, refer to Senlab User Guide 

Device network activation process 

Activation status is displayed in column “RF Level” of “Network” view (since V2.4.2) 

• Status : device is provisioned and no message has been received yet 

• Status : the device “activation/join request” has been received and 

accepted by the gateway (“join accept” has been transmitted to the device) 

For previous SLgateway version, activation status are not displayed. 

Important: Network activation is successful only if the device has received the “join 

accept” (LED ON 2sec) 

Device application start 

After network activation, device send an application “start message” (contains the 

current configuration), before sending the first data (with sensor measures). 

• For picoGw: “Start message” will be sent 2 min after the “join” (3ch limitation) 

• For 8-CH, “Start message” will be sent a few second after the “join” 

 

Senlab current configuration will be displayed in the “Application device detail” view 

https://support.sensing-labs.com/hc/en-us/articles/360028474072-30-How-to-switch-from-a-network-to-another-one-
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Device data transmission 

Depending of the data transmission period of the device, device messages will be 

automatically decoded and accessible into the “Application device detail” view 

➢ Last measure is displayed into the list of devices int the “Application” view 

➢ Measures are presented via graphics & tables into the device detail view 

 

➢ For non Senlab devices, received payload are available into the “Network device 

detail” view. 
 

 

Device has successfully started if not empty  
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STEP 4: Device data access via APIs 
 

The following APIs are available for recovering application data from SLgateway: 

• Rest API 

• HTTP Callback 

• MQTT 

• CST-to-FTP 

• Elacticsearch 

• Sentilo 

• Modbus API 

More than one API type can be used at the same time (for test or dev for example). 

We strongly advise to study all possibilities and to choose the best API that fit with your 

use case and your IT environment: 

➢ Do you have an IP access to the SLgateway? 

➢ Does the GW is connected to a PLC or a webservice? 

➢ Do you want a one-way or bidirectional API? 

➢ Do you want a “on request” or “send only” API? 

➢ Does your use case need a “real-time” or a “post-processing use” (see table)? 
SLGateway API Real-time use Post-processing use 

HTTP Rest API Limited (need a high freq. request process VS log 

freq) 

Yes 

HTTP Callback API Yes Yes 

MQTT Yes Yes 

CSV-to-FTP No Yes 

Elasticseach No Yes 

Sentilo Yes Yes 

Modbus API Limited (need a high freq. request process VS log 

freq) 

Yes 

 

 Don’t hesitate to ask our support for an advise about how to choose the API. 

 

How to check APIs, devices and SLgateway version compatibility ? 

We provide a  document (link here) with compatibility table between: 

• Senlab FW 

• SLgateway version 

• SLgateway APIs 

• LoRaWan feature 

 

  

https://support.sensing-labs.com/hc/en-us/requests/new
https://support.sensing-labs.com/hc/en-us/articles/360015691571-Application-note
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Rest API 

SLgateway Rest API is natively available on all SLgateway, and is always available. 

➢ You will be able to choose your language & see how to interface with the API. 

➢ If you want to test easily the API with Postman tool, you can download the 

API_REST_SLgateway_V2_tools.zip here and follow README file instructions. 

➢ All HTTP responses are GZIP encoded. 

➢ The default authentication ("Basic auth" type) is the same as the GUI access: 

public/public 

➢ HTTP Methods: GET, PUT, DELETE, POST 

➢ Main format of the Rest API url: 
http:{{gwIP}}/com.sl.application.server/V1.0/{{devEUI}}/{{applicationId}}/{{measureId}} 

➢ Main requests: 

o Get list of devices (GET) 

o Get device measureId values (GET) 

o Get all device measures values (GET) 

o Get device eventId value (GET) 

o Get device payloads hexadecimal values (GET) 

o Send Senlab downlink request (POST) 

Full Rest documentation and requests are available online. 

Rest API also allows powerful features like devices and GW management (refer GW app 

notes support website). 

HTTP Callback 

“HTTP callback” service allows the SLgateway to push received data to an HTTP 

listener deployed onto your own server, in “real time”. 

➢ Two formats are available: 

o xml 

o json (same as SLcodec) 

Two types of callbacks can be configured: 

➢ Data Callback notifies decoded data (measures/events) for Senlab devices only 

➢ Payload Callback notifies hexadecimal payload for non-Senlab devices and 

Senlab (you can choose to receive payload only for non-Senlab devices) 

 

LoRa device(s)

SLgateway

HTTP Callback 
service

(your server)
HTTP Listener

https://support.sensing-labs.com/hc/en-us/categories/360000497012-SLgateway
http://sensing-labs.com/apis/rest
https://support.sensing-labs.com/hc/en-us/articles/360015691571-Application-note
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HTTP Callback configuration (SLgateway side) 

Access to “APIs → HTTP Callback” page 

 

1. Choose options: 

o Content-compression: gzipped (by default) or plain 

o Payload filter: notification with or without Senlab devices 

2. Optional header (only for json format): if you want your header into each json 

3. Enter the callback URL(s) (the 2 servers URL + format can be the same or different) 

 

 

 

4. You can test the Callback URL accessibility using the button . 

5. Save configuration with button   (modification will be applied in 30’’ max) 

To disable the callback function, just empty the form and click SAVE button 

 

In case of GPRS connection, we strongly advise you to: 

- edit the “hosts file” by SFTP connection and add the line (refer to “advanced 

configuration”): 

188.23.222.432 yourweburl.com 

(that will decrease the request delay and the GPRS data consumption) 

 

Callback format 

Refer to "SLgw APIs formats" Application note  

Sample url Description of the sample url 

http://192.168.1.68:8000/callback#json Json with specific port 

http://192.168.1.68/callback#json Json with default port (80) 

non authentified server 

http://192.168.1.68/callback#xml xml format with default port (80) 

https://username:password@www 

yourdomain.com/callback#json 

Json with https 

with authentication 

https://support.sensing-labs.com/hc/en-us/articles/360015691571
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MQTT 

SLgateway MQTT integrated client allows to publish data and/or payload to an external 

broker and to subscribe to a downlink topic (for device reconfiguration). It supports 

MQTTS and private certificate can be specified. 

Data (or payload) are published as soon as the radio message is received by the GW. 

MQTT configuration (SLgateway side) 

1. Access to “APIs → MQTT” page to configure your MQTT URL, ClientID and pub/sub 

topic 

 

 

 

 

2. After, , then  your configuration is working. 

o Once configuration is OK, you need to restart service “API Server” 

Information:  

o Standard MQTT port is 1883 and (port 8883 for MQTTS) 

o MQTT protocol version is 3.1.1 

o QoS (Quality of Service) of MQTT published messages: 

▪ QoS 0 (V2.3.x only) 

▪ QoS 1 (possible on V2.4.x and 2.5.x with a patch ➔ ask us) 

▪ QoS 2 (since V2.4.2) 

o MQTT auto resubscribe after disconnect/reconnect 

3. If you have private MQTTS certificate, you will have to upload the following files 

into SFTP /certs repository, and relaunch the  

o CA : /certs/ca.crt 

o Cert : /certs/cert.pem 

o Key : /certs/private.key 

4. Pay attention that "Google Cloud IoT Core" don’t use standard MQTT protocol, so 

it is not compatible with SLgateway. Rather, “AWS IoT Core” is standard and Is 

compliant with SLgateway MQTT API. 

We advise some useful link to test and dev with MQTT : see FAQ.  

publish raw payload 

(undecoded) 

 

publish decoded data 

(from Senlab only) 

 

 

Set a unique clientID (e.g.  GatewayID or siteID) 

IMPORTANT : 

set a different clientID per SLGw 

Topic to reconfigure 

devices (over downlink) 

https://sensing-labs.zendesk.com/knowledge/articles/360016984299
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In case of GPRS connection, we strongly advise you to: 

- edit the “hosts” file by SFTP connection (contact us for more details) and add 

the line: 

188.23.222.432 yourweburl.com 

(that will limit the request delay and decrease the GPRS data consumption) 

 

The same MQTT connection can be used for “fleet management”: SLgateway App. 

Note page. 

 

MQTT format 

Refer to "SLgw APIs formats" Application note 

CSV to FTP 

“CSV to FTP” service allows the SLgateway to push periodically all measures (only Senlab 

decoded “measure”, no “event”, no “payload” from generic device) received since 

the previous transmission, in a CSV format, to an FTP/SFTP/FTPS server. 

The retention size is 4000 lines (FIFO) or 100 days. 

Four CSV formats are proposed: 

•  “Generic”: default format 

• “DK”: specific use (name was “format 3” until V2.2.0) 

• “DT”: specific use (name was “format 2” until V2.2.0) 

• “Dexma”: format for DEXCell Energy Manager platform 

File format 

Refer to "SLgw APIs formats" Application note 

Contact us for another format customization. 

 

CSV to FTP configuration 

access to “APIs → CSV to FTP” page 

https://support.sensing-labs.com/hc/en-us/articles/360015691571-Application-note
https://support.sensing-labs.com/hc/en-us/articles/360015691571-Application-note
https://support.sensing-labs.com/hc/en-us/articles/360015691571
https://support.sensing-labs.com/hc/en-us/articles/360015691571
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1. Enter your server 

configuration and 

validate with button  

a. Site ID can be used to identify your gateway ID 

b. Periodicity off (Sent every (hours)) → Service deactivated 

2. Use button  to check the connection to your server 

3. Use button  to force the transmission of a csv file 

The \ (backslash) character is not authorized in the password 
 

After first CSVtoFTP configuration, all stored data are sent, by batch of 2000 lines. 
 

Tricks: Once your FTP connection is valid You can check and compare CSV format with 

  and check file on your server side. 

Elasticseach 

SLgateway embed a native API to push periodically all measures received since the 

previous transmission to the Elasticsearch platform. 

You need an active Elasticsearch account and a valid server (refer to www.elastic.co) 

Elasticseach configuration (SLgateway side) 

access to “APIs → Elasticsearch” page 

 

1. Fill the forms: 

a. Elasticsearch URL: user & password & your ES server 

https://www.elastic.co/
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URL format is: https://user:password@your_ES_server 

b. Index name: “measures” or any name fitting to your ES configuration 

c. Update interval (minute): periodicity of the sending process to ES server 

2. Save configuration with button  and activate with  

Sentilo 

SLgateway embed a native API to push all measures the Sentilo platform. 

You need an active Sentilo account and a valid server (refer to www.sentilo.io) 

Sentilo configuration (SLgateway side) 

access to “APIs → Sentilo” page 

 

 

1. Fill the forms: 

a. Your Sentilo server URL 

b. Your identity key (“your provider's token”) 

c. Provider (“your provider”), linked to your token 

2. Save configuration with button  and check all is working with button  

 

Measures are forwarded as soon as they are received (sentilo “push mode”). 

For more information about Sentilo: Quick start with Sentilo  

Modbus API 

“Modbus API” service allows the SLgateway to be exposed as a TCP Modbus Server. 

In this mode, last payload & decoded data are exposed into specific Modbus registers. 

➢ Modbus is not activated by default (see process bellow to config and activate it) 

➢ Only the last received payload or decoded measures are exposed into Modbus 

registers. You have to set your request period to the device transmission periodicity 

(minimum requests period is “one minute”) 

➢ Need at least one valid value per device before to “read” this device with Modbus. 

➢ Maximum number of managed devices: 200 (Modbus API) 

This step must be executed only once devices are provisioned into the gateway, 

and anytime you change your device list. 

http://www.sentilo.io/
http://www.sentilo.io/xwiki/bin/view/Sentilo.Community.Documentation/Quickstart


 

©2020 Sensing-labs 

29 Sensing Labs SLgateway V2.5.x – User Guide E02 rev I 

 

Modbus mapping configuration 

access to “Tools  → Modbus mapping” page. 

Device with “Device index = 0" means that the device is not mapped to a 

Modbus register. 

By default, all new devices are affected to “Device index = 0". 

1. You can assign device index manually (from 1 to 200) or call  to let the 

system assign them. 

2. Valid the mapping with  

3. You can download in a csv file the current mapping with  

4. To apply the new mapping, you have to restart Modbus service with  

 

Next step: 

Once the Modbus API is well configured and activated on SLgateway, you can refer 

to the Modbus Register Table to find useful information to configure your Modbus 

software or PLC to get SLgateway Modbus data.  

http://sensing-labs.com/apis/modbus
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Troubleshooting 

I don’t succeed to activate my device onto the gateway 

Keep in mind the following process of radio message reception to try to found where 

the issue comes from? 

✓ You can activate real time “logs” (into “Maintenance→ Services” page) to observe 

received and sent frames when you try to activate your device 

 

 

 

  

RF LoRa Modem
•Hardware layer

•RF input

•RF LoRa frame

Network Server

•Frame decoding

•Device authorization

•Frame storage

•LoRa MAC management

•Downlink synchronization

Application Server

•Message decryption

•Senlab decoding

•Senlab real time process

•Data storage

GUI/Export Data
•Data formating

•Data displaying

•Data sending
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I have forgotten the current IP network gateway configuration 

You can access to a permanent Ethernet interface of the gateway by using a USB 

cable. 

✓ You need: 

✓  a “Type A to mini-B USB cable” 

✓ To install USB/virtual Ethernet driver: 

 

 

✓ In some cases, you would need to 

set your local emulated ethernet 

IPv4 to 192.168.7.1 (sub network 255.255.255.0).  

If you have “driver signature trouble”, help is here. 

 

Follow this process: 

1. Turn ON the SLgateway (with power supply plug) 

2. Wait for the 2 leds blinking (under LoRa antenna) 

3. Plug the USB cable between computer and gateway 

4. Wait for Linux USB ethernet / RNDIS connection into 

your computer network configuration (driver self-

extracting)  

5. Access to http://192.168.7.2 with your internet browser 

and check your IP network configuration into 

“Maintenance → System” page 

On MacOSX, you may need to access to http://192.168.6.2 instead. 

You can also come back to the default configuration: refer to “How to come back to the 

default Ethernet configuration (static 192.168.2.1)?” 

I have forgotten the user and/or password to access to the GUI 

Follow the process described in SLgateway FAQ page to restore “public/public”. 

  

OS Link for driver 

Windows 64 bits Download here  

Windows 32 bits Download here  

MacOSX 

Download 1 here and Download 2 

here 

and read help here 

https://www.howtogeek.com/167723/how-to-disable-driver-signature-verification-on-64-bit-windows-8.1-so-that-you-can-install-unsigned-drivers/
http://192.168.7.2/
http://192.168.6.2/
https://support.sensing-labs.com/hc/en-us/articles/360015688571
http://beagleboard.org/static/Drivers/Windows/BONE_D64.exe
http://beagleboard.org/static/Drivers/Windows/BONE_DRV.exe
http://beagleboard.org/static/Drivers/MacOSX/RNDIS/HoRNDIS.pkg
http://beagleboard.org/static/Drivers/MacOSX/FTDI/FTDI_Ser.dmg
http://beagleboard.org/static/Drivers/MacOSX/FTDI/FTDI_Ser.dmg
https://learn.adafruit.com/ssh-to-beaglebone-black-over-usb/installing-drivers-mac


 

©2020 Sensing-labs 

32 Sensing Labs SLgateway V2.5.x – User Guide E02 rev I 

How to configure my SLgateway to static IP address (Ethernet)? 

1. Connect to the gateway using Ethernet (current 

configuration) or USB cable. 

2. Access to the config page: “Maintenance → 

System”, with button  

3. Choose “static” 

4. Fill all the forms 

(Since V2.4.2, IP value suggestion appears after 

you fill the “Address”). 

If you are already using the ethernet connection, you could see two “eth0”. The 

two addresses are available until next reboot. 

Reboot with  (check cable is connected to the new 

local network) 

5. Your gateway is now reachable only on new IP address! 

Tricks: 

➢ If you have problem with DNS (when you try to reach an URL, not an IP), you can 

“fix DNS” with button  and try to reach the URL again. 

You can also try to use this DNS servers: 1.1.1.1 and 1.0.0.1 (contact us for more 

details) 

➢ if you don’t know what to put in “gateway”, “DNS1” and “DNS2” form, repeat 

your static IP address)  

Using ethernet static IP and GPRS connection on the same time is technically 

possible but you can have DNS trouble (because the GPRS connection will 

replace the “manual” DNS). It is better to choose GPRS only OR static IP only. 

 

How to come back to the default Ethernet configuration (static 192.168.2.1)? 

You can change the default Ethernet configuration to fit to your local network from 

“Maintenance → System”, with button  

Fill the form as below: 
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How to recover all data stored in my SLgateway? 

You can download all data stored in SLgateway (until 100 days) in on CSV file. 

You can choose from date to date, and the type of data: 

Measures or Payloads. 

1. Access to the page: “Tools → CSV Export”, 

2. Choose first and last dates 

You can check the number of lines 

3. Download CSV file you need. 

 

 

Some function (downlink queue) can be delayed or cancelled during the "Export 

process”, up to a few minutes in case a many data to export. 

Do you have any other questions? 

You can check  SLgateway FAQ page and read useful answers. 

How to get technical support? 

More information (tutorials, FAQ, document, news), are available on the SLgateway V2 

support website. 

✓ You will have to register first here  

✓ If you have as specific question, or doesn’t found the solution to an issue, please 

create an online ticket here 

Thank you for given maximum information about the issue to get a faster response 

from support 

(services logs, device ID / type, APIs configuration / Remote access support) 

  

https://support.sensing-labs.com/hc/en-us/sections/360002040732-F-A-Q-
https://support.sensing-labs.com/hc/en-us/categories/360000497012-SLgateway
https://support.sensing-labs.com/hc/en-us/categories/360000497012-SLgateway
https://sensing-labs.com/support-registering/
https://support.sensing-labs.com/hc/en-us/requests/new
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Annex - GUI 

GUI structure (V2.4.x) 

 

Header contains the global menu to access to all pages and displays the gateway 

friendly name. 

 

Footer indicates: 

✓ The unique identifier of the gateway “gatewayId (also on the back label) 

✓ ADR: mono-SF (picoGW) or multi-SF (Gateway-8CH) 

✓ The last hour Duty Cycle counter (%), for each channel 

✓ The version of the engine (also called SLgateway version) 

✓ The Radio Frequency Board Firmware version 

✓ The current gateway UTC time. 

 

All this information can be useful when you ask for technical support  

 

 

 

 

 

 

Application

Device list

• Application status

• Last measures

Device detail

• Device status

• Application configuration

• Data history

Network

Device list

• Network status

• Last reception

Device detail

• Device status

• Payload history

• RF level

• Advanced configuration

Add a new 
device

APIs

HTTP callback

MQTT

CSV to FTP

Elecsticsearch

Sentilo

Modbus

Tools

SLsetting import

CSV Export 

Remote
Management

SLTester

Maintenance

GUI settings

Network settings

Services

System

Update

About

gatewayId Live Duty 

cycle check 
SLgateway 

version 

(software) 

RF board version 

(firmware) 
Current UTC 

time 
ADR 
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Application – device list 

This page gives an overview of application status for all device: 

 

➢ Click on a “device row” to access to device application detail 

➢ For “Unknown” application Type, you will be redirect to device network detail 

 

Application – device detail 

 

➢ to Edit application configuration, click on button   

o Configuration field depends on application Type 

o Send the new configuration with button  

 

New configuration will be transmitted as soon as new uplink message will be 

received.  

Friendly 

name 

Last received measures 

(if there is) 

Application Type 

(automatically detected for 

Senlab / Unknown for other) 

Take care if the 

connection is 

GPRS/3G 

Filter on all 

columns 

Edit 

configurati

on 

current 

application 

configuration 

Device application 

status recall 

Shortcut to 

device network 

detail 
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You can follow downlink status into Network detail page. 

➢ Data history are visible into a graphical & a table 

 

 

 

 

Network – device list 

 This page gives an overview of network status for all device:  

 

 

 

➢ Click on a “device row” to access to device network detail 

 

 

Number of value 

up to  last 500 

Move the mousse over graph 

to get exact value and 

timestamp 

 

Timestamp 

based on local 

time zone 

CSV export of 

the table 

values 

Senlab 

Firmware 

version 

Take care if the 

connection is 

GPRS/3G 

Filter on all 

columns 

Radio 

link 

quality 

Reception rate 

(based on up 

counter) 
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Network – device detail 

➢ Device status 

 
 

➢ 50 last Payload history 

 

➢ RF level history 

 

Refer to RF LEVEL RESULT INTERPRETATION section for interpretation of RF level data. 

 

➢ Downlink payload can be sent to device 

Link to down 

page 

informations 

Shortcut to 

device 

application 

detail 

Timestamp 

based on local 

time zone 

CSV export of 

the table 

values 

Frame direction              

Uplink: from device to gw 

Downlink: from gw to 

device 

Green: RSSI                      

Blue: Signal Noise Rate         

Orange: cumulated RSSI + 

SNR 

Move the mousse over graph 

to get detail values 

 

Timestamp 

based on local 

time zone 

CSV export of 

the table 

values 
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o Send the hexadecimal payload with button  

o Sending status can be follow into “Downlink queue” 

▪ Waiting for uplink frame / Sent to device / Success / Failed 

o You can remove all “Not sent” frame using button  

You can choose the type of downlink: 

• “Confirmed”: downlink is sent until acknowledgement from 

device (number of retry can be set in Maintenance - Network 

settings) 

• “Unconfirmed”: no retry in case of unconfirmed status 

 

➢ Advanced settings for experts : Network, Application & Commissioning 

o You can change friendly name using  

o (Gateway-8CH only) You can also disable ADR (enable by default) 

o Network advanced configuration must not be changed (only for experts) 
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 Any bad setting in Network advanced configuration can definitely lost the 

connection with device. 

Tools – Remote management 

How to connect remotely to SLgateway? 

How to manage a fleet of  SLgateway and devices ?  

You can check SLgateway App. Note page and read useful answers. 

Tools – SLTester 

SLtester allows to test your local LoRaWAN network coverage with high reliability. 

Why using SLtester ? 

➢ Radio Range validation before deployment 

➢ Same RF performance as deployment site 

➢ Devices and gateway position validation 

➢ Indoor and/or Outdoor test devices 

➢ Simple status interpretation 

 

If you get the package SLtester kit: 

➢ You can register your mobile phone to receive each test status in live by SMS 

➢ Your Senlab Test device(s) are already associated with the gateway 

➢ Test can be made in standalone mode (no need to access to GUI during test) 

You need to get at least one Senlab Test device(s) to make test coverage. 

Contact us if needed. 

You need to be sure your Test device is not already registered into another 

SLgateway. 

STEPS to follow for making a test session (without SMS option)? 

1. Install your gateway 

✓ Respect installation recommendation 

✓ Turn it ON (with power supply) and wait for starting (1min) 

2. Access to “Tools → SLTester” page to add your Test device  

✓ The Senlab ID is on the front sticker of the device casing 

✓ At the end of the Test session, Test device must be removed and RESET 

3. Position your Senlab Test device at the expected location 

(without holding the device with hand) 

✓ Prefer vertical position (antenna part upwards) in a 

free space area (higher place if possible) 

✓ Avoid positioning the Senlab Test device against a 

metallic element 

Outdoor Test 

device 

 

Indoor Test 

device 

 

Senlab Test 

A0101801 

up 

Best position Acceptable 

https://support.sensing-labs.com/hc/en-us/articles/360015691571-Application-note
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4. Press the device push button 2 seconds (until LED starts blinking) 

✓ Wait for 20 seconds during range test processing (LED blinking) 

5. Check Quality level on “SLtester” page 

 

 

✓ If level is GOOD → you can go to the next place test and start from step 5 

✓ If level is FAIR → you can try to improve the sensor position 

                            and launch a new test point and start from step 5 

✓ If level is BAD → you have to improve the gateway position 

                            and launch a new TEST session from the beginning (step 1) 

 

✓ If Senlab LED blinking doesn’t finished by 2” ON or if you didn’t receive the TEST 

status 

        -> TEST status has to be considered BAD 

✓ If you received a BAD status, it’s recommended to launch a new TEST to 

confirm the result 

 

✓ The gateway must be kept in the same position during all this test session. 

 

Using SLtester collecting field form is recommended for an easy coupling of location 

and quality, for each Test in a single document. 

1. Describe the exact place and position of the SLgateway in top part of the “SLtester 

collecting field form”. 

 

 

 

2. For each test, fill a new line table with  

✓ Test Location (more precise is better) 

✓ Time for easy post-processing interpretation 

✓ Test device ID (devAddress printed onto the device) 

✓ Test Number & Quality level (appears in the report page) 

 
 

For OUTDOOR RANGE TEST, we recommand to use a GPS tracking tool 

You can use the Android free app “Quick Position Save” with this process:  

➢ Name the point with Test number 

Senlab Test device location Test number (= Test ID) 

https://play.google.com/store/apps/details?id=com.matt.quickPositionSave
https://play.google.com/store/apps/details?id=com.matt.quickPositionSave
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➢ Export kmz file at the end of the TEST session 

➢ Display GPS point on a map and associate to Test points 

 

RF LEVEL RESULT INTERPRETATION 

Into “Tools → SLTester” page, choose your Test Senlab ID to filter results for this ID  

➢ A Quick interpretation status is indicated based on multiples uplink and downlink 

received level during each Test point. 
 

 

 

➢ Details RF levels for each Test point are available into bottom part. 

 

 

 

 

 

➢ You can export table result with  to process them with your own tools.  

 

✓ Don’t change the friendly name of Senlab Test device 

✓ If you want to remove a Test device from your gateway (Network tab), you will 

have to RESET it before the association with another gateway → Keep the 

magnet 20’’ until LED stay ON 5’’ 

  

Uplink: from device to gw 

Downlink: from gw to device Frame #ID for a given 

Test 

RSSI and LSNR level 

RF level is not optimal but must 

be sufficient 

→ Try to improve your device 

position if possible 

→ You will have to monitor the 

stability of the RF level 

RF level is optimal to get a 

good reception reliability 

FAR AWAY environment 

→Try to put device higher 

NO or INSUFFICIENT reception 

→ Try to put the gateway 

higher or maybe you will 

have to install an additional 

gateway 

→ In all cases, a new Tests 

NOISY environment 

→Try to put device out of 

electromagnetic sources 
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Maintenance - Network settings 

You can customize the LoRaWan appEUI and netID code for your local radio network 

from “Maintenance → Network Settings” page 

➢ Be sure you have your own LoRaWan alliance codes to use them. 

You can also change the number of downlinks retry. 

 

 

 

 

 New network configuration will be applied to new devices only 

You can check the network type: PUBLIC (by default) or PRIVATE (PicoGW only) and the 

current channels of the gateway (frequency, bandwidth, Spread Factor). 

➢ (PicoGW only) These parameters can by customize by uploading of a new config 

file. 

For any other configuration, please please create an online ticket here 

➢ Typical “Frequency plan” (left screen= PicoGW, right screen= Gateway-8CH): 

   

Theses parameters need to be change only BEFORE a new installation 

(communication with previous attached devices will be lost).  

http://support.sensing-labs.com/projects/slgateway-v2/issues/new
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Maintenance - Services 

The “Maintenance → Services” page give status of SLbase services 

➢ In case of trouble, you can check if they are active and the uptime. 

➢ “Backup / Restore” allows you to save full configuration and data to a file, and to 

load it in another SLgateway. 

o To backup, use button  and save the “redis file” to your 

computer 

o To restore, use button  and choose “redis file” in your computer, 

then use button  to load it into your SLgateway 

If you use “CSV to FTP”, contact us to reinitialize for “CSV initialization”. 

If you need to restore configuration in a new gateway, check FAQ . 

 

➢  “Network & Applications logs” allows to see in real time services logs 

o Use buttons  to activate them 

o You can also download logs to send them to support with button  

We recommend you to let the default “Logging – console level” configuration 

Maintenance - System 

In addition, with “IP network” & “GSM configuration”, the “Support remote access “in 

page “Maintenance → System” allows you to activate remote access for support 

investigation: 

1. Buttons  will activate/deactivate the remote 

access until the next gateway reboot 

2. Buttons  will register/unregister the remote 

access when gateway is turn ON. 

 

  

https://support.sensing-labs.com/hc/en-us/sections/360002040732
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Legals 
 

SENSING LABS SAS reserves the right to make corrections, modifications, 

enhancements, improvements and other changes to its products and services at 

any time and to discontinue any product or service without notice. 

 

SENSING LABS products is not authorized for use in safety-critical applications 

(such as life support) where a failure of the product would reasonably be expected 

to cause severe personal injury or death, unless officers of the parties have executed 

an agreement specifically governing such use. 

 

Buyers confirm that they have all necessary expertise in the safety and regulatory 

ramifications of their applications, acknowledge and agree that they are solely 

responsible for all legal, regulatory and safety-related requirements concerning their 

products and any use of the product in such safety-critical applications, 

notwithstanding any applications-related information or support that may be 

provided by SENSING LABS SAS. 

 

 

© 2020 SENSING LABS SAS. All rights reserved. Sensing Labs logo, are registered 

trademarks of SENSING LABS SAS. All other brands and product names mentioned in 

this document are the property of their respective holders.  

This is a non-contractual document and specifications are subject to change at any 

time without notice. 

 

 

For more information about this software: 

website - http://www.sensing-labs.com 

Support - http://support.sensing-labs.com 

 

Headquarters:  

SENSING LABS SAS. 

CAP OMEGA, 

rond point Benjamin Franklin 

34960 Montpellier cedex 02 – France 
 

 

http://www.sensing-labs.com/
http://www.sensing-labs.com/
http://support.sensing-labs.com/

